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Overview 

Introduction to The Ultimate Collaboration Tool: An Introduction to OneNote 

Learning is more powerful and dynamic with tools that are already right in front of you – and it’s up to 

educators to impress this on students in the classroom. 

With Microsoft OneNote, educators can create digital notebooks that support academic standards and 

education outcomes across disciplines and tasks, such as writing, reading, mathematics, science, history, 

CTE, and elective courses. Students may use OneNote across content areas and grade levels, and use 

OneNote to compile and organize unstructured information, research, and content. OneNote also 

supports research, collaboration, information management, communication, note taking, journaling, 

reflective writing, and academic requirements. 

Teachers and students will develop the basic skills needed to use OneNote as a productivity tool for both 

themselves and their students. Time will be devoted to assist a teacher in understanding how OneNote 

can be used as a true collaborative tool. Interactive lessons will be created using the tools in OneNote 

which will then immediately transfer to classroom practice. Finally, teachers will experience and discover 

how Professional Learning Communities can be more productive when using OneNote to drive content 

delivery and creation. 

At the end of the day, participants should leave feeling comfortable and knowledgeable in the basic skills 

necessary to be up and running successfully using OneNote in the classroom, and as a professional tool. 

How to use this guide and conduct the Teacher Academy 

This six-hour session is designed for presenting to groups of teachers, varying in size (with a 

recommended maximum of 25). 

This trainer guide walks the trainer through the setup and delivery of a Teacher Academy. It is intended to 

provide all the information you need to confidently lead the training. Here are some tips to help make 

your training sessions as effective as possible: 

 Table of Contents. Navigate this guide more easily using the Table of Contents above. 

 Academy Outline. This guide can be used as a “cheat sheet” when you are conducting the 

academy to help you remember the order and timing of topics to be covered. 

 Preparation. Be sure to set up the necessary equipment in advance so that it’s ready for  

your session. 

 Timing. The actual amount of time it takes to conduct this session will vary depending on the 

knowledge level and learning style of the participant(s). Be prepared to make adjustments on the 

fly, using the time estimates provided in the document as a guide. Six hours have been scheduled 

for this Teacher Academy. 
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Academy Session Objectives 

By the end of this session, participants should feel confident with basic use of OneNote, and be able to: 

 Speak to the benefits of OneNote use in the classroom, being confident navigating and using 

OneNote, as well as setting up, organizing and arranging notebooks for student and teacher use 

of OneNote as a productivity tool. 

 Understand how teachers and students can use OneNote as a collaborative tool – 

performing tasks like creating a OneNote notebook, adding a new location and sharing  

an existing notebook. 

 Creatively apply learning to how it will benefit students and teachers for specific classroom tasks, 

including creating interactive lessons using tools within OneNote. 

 Become familiar with OneNote best practices such as consistent use and practice, and continue 

the learning through a Professional Learning Community and additional resources. 

The Trainer’s Role 

The trainer’s role is to help educators get the most from the activities provided and motivate them. 

Learning will only be embedded once ideas and activities are put into practice. Facilitation should model 

the same approaches to teaching and learning that it aims to develop. Educators who develop awareness 

and understanding of their own learning as they progress can apply this knowledge more confidently. 

Such a reflective dimension might also help support their students in developing an understanding and 

awareness of their own learning, thus modelling effective aspects of teaching and learning as an integral 

part of the course design and pedagogy. 

Target Audience Guidance 

The primary audience for this session is teachers, empowering educators teaching in a variety of settings. 

That said, knowing your audience will likely be critical for successful application of the topics. Establish the 

background of your audience early in the learning process, and monitor and adjust to meet the needs of 

the group. 

It is invaluable for anyone eager to learn how they can engage their students in intuitive and powerful 

ways using OneNote. 

Recommended size for this academy is 25 educators with one trainer. 

Length  

Six-hours (plus a 1-hour recommended lunch) 
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Where OneNote Can Help You Meet U.S. Common Core State Standards: 

Note:  This Core Standards information is also included for participants in their OneNote Handbook, in 

the Lesson Development (green) section, on page 6. 

K-2 

 With guidance and support from adults, use a variety of digital tools to produce and publish 

writing, including in collaboration with peers. 

 Create audio recordings of stories or poems; add drawings or other visual displays to stories or 

recounts of experiences when appropriate to clarify ideas, thoughts, and feelings. 

 Gather information using teacher-selected digital resources. 

3-5 

 With guidance and support from adults, use technology to produce and publish writing (using 

keyboarding skills) as well as to interact and collaborate with others. 

 Ask and answer questions to demonstrate understanding of a text, referring explicitly to the text 

as the basis for the answers (including text in digital format). 

 Conduct short research projects that use several sources to build knowledge through 

investigation of different aspects of a topic. 

 Recall relevant information from experiences or gather relevant information from print and  

digital sources; summarize or paraphrase information in notes and finished work, and provide a 

list of sources. 

 Use interactive resources to practice skills, explore new concepts and describe patterns. 

6-8 

 Generate creative solutions and present ideas. 

 Integrate multimedia (a combination of text, images, sound, music, and video) and visual displays 

into presentations to clarify information, strengthen claims and evidence, and add interest. 

 Interact and collaborate with others using a variety of digital tools. 

 Communicate information and ideas effectively to multiple audiences using a variety of media 

and formats. 

 Use technology, including the Internet, to interact and collaborate with others. 

 Use technology, including the Internet, to produce and publish writing and link to and  

cite sources. 

 Use technology, including the Internet, to present the relationships between information and 

ideas clearly and efficiently. 

 Conduct short research projects to answer a question (including a self-generated question), 

drawing on several sources and generating additional related, focused questions that allow for 

multiple avenues of exploration. 

 Combine information from separate sources to produce, support, and counter arguments. 

 Gather relevant information from multiple print and digital sources, using search terms effectively; 

assess the credibility and accuracy of each source; and quote or paraphrase the data and 

conclusions of others while avoiding plagiarism and following a standard format for citation. 

 Draw (freehand, with ruler and protractor, and with technology) geometric shapes with  

given conditions. 

 Gather data, examine patterns and apply information for decision making using digital tools  

and resources. 
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9-12 

 Organize ideas and design and produce multimedia projects. 

 Use technology, including the Internet, to produce, publish, and update individual or shared 

writing products, taking advantage of technology’s capacity to link to other information and to 

display information flexibly and dynamically. 

 Use technology, including the Internet, to update individual or shared products in response to 

ongoing feedback, including new arguments or information. 

 Use databases and digital resources to organize a project. 

 Conduct short as well as more sustained research projects to answer a question (including a  

self-generated question) or solve a problem; narrow or broaden the inquiry when appropriate; 

synthesize multiple sources on the subject, demonstrating understanding of the subject  

under investigation. 

 Gather relevant information from multiple authoritative print and digital sources, using advanced 

searches effectively. 

 Assess the usefulness of multiple sources in answering the research question. 

 Combine information from separate sources to produce, support, and counter arguments. 

 Integrate information into the text selectively to maintain the flow of ideas, avoiding plagiarism 

and following a standard format for citation. 

 Develop and strengthen writing as needed by planning, revising, editing, rewriting, or trying  

a new approach, focusing on addressing what is most significant for a specific purpose  

and audience. 

Materials, Supplies and Setup 

Equipment 

 Screen display for trainer. 

 Windows 8.1 device (i.e. Surface Pro, tablet, laptop or desktop PC) for trainer, loaded with 

Microsoft Office. 

 All participants should have a Windows 8.1 device (i.e. Surface Pro, laptop, tablet or desktop PC), 

loaded with Microsoft Office. Before starting, determine if all participants have a Windows 8.1 

device, and request participants to share devices if applicable. There should not be any more than 

two participants per device. 

Setup 

 Ensure the OneNote Participant Handbook (a Single File Package supplied as an asset for this 

academy) is easily accessible for participants to use. 

o An example of a distribution approach would be for the trainer to prepare flash drives (or 

a network location), so the participants can copy and open the OneNote to their devices. 

Software/Applications 

 Microsoft Office, including Microsoft OneNote. 

Materials 

 Teacher Academy Outlines/Trainer Guides and support presentation for Trainer. 

 OneNote Participant Handbook notebook. 
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Academy Outline 

Use the outline below as a “cheat sheet” when conducting the session. 

Note:  The recommended 1 hour lunch is not taken into consideration in the times listed below. 

Elapsed 

time 

(min) 

Time 

(min) 
Topic Description 

Section #1: Introduction (5 minutes) 

:00 1 Welcome (15 minutes before class, display Slide 1.) 

Introduce yourself. 

Introduce The Ultimate Collaboration Tool Academy.  

:01 1 Logistics Review session housekeeping items. 

:02 3 Teacher Academy Overview Give a high-level overview of the day. 

Section #2: OneNote Overview (45 minutes) 

:05 45 The Basics Introduce OneNote and discuss the available features, 

starting with the high-level learning objectives that will 

be covered. 

Section #3: OneNote as a Personal Organization Tool – Part I (50 minutes) 

:50 50 Demonstration Continue with the OneNote overview, going further by 

providing participants with an orientation and 

demonstration of the OneNote interface. 

Topics should include: 

 Setting up a OneNote 

o Creating a new notebook 

o Opening a notebook 

o The Bookshelf (show how to pin and 

unpin the notebooks) 

o Sections (create, change colors,  

sub sections 

o Pages (adding, deleting, naming) 

 Ribbons 

 Saving/Syncing 
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Break (10 minutes) 

Section #4: OneNote as a Personal Organization Tool – Part II (60 minutes) 

1:50 60 Demonstration Take a deeper dive into some of the most commonly 

used tools of OneNote. 

Topics should include: 

 Home tab 

 Add Page and Play Page 

 Other tabs: 

o Insert tab 

o Draw tab 

o History tab 

o Review tab 

 Page Versions, Recycle Bin, creation of a  

2-column table with translation and  

file>rule lines. 

Lunch Break (1 hour recommended) 

Section #5: Skills Review (40 minutes) 

2:50 5 Introduction Direct participants to the tab in their notebook titled: 

Review, and give them a brief overview of the tasks. 

2:55 35 Practice Have participants practice skills learned in the morning 

session, using the Review Notebook. 

Section #6: Using OneNote in the Classroom (70 minutes) 

3:30 5 Introduction to the Second 

Half of the Day 

The second half of the session focuses on classroom 

application. This session is intended to provide 

participants an opportunity to create a lesson they can 

use immediately in their classroom. 

3:35 40 Explore Notebook Examples Spend time showing examples of ways other teachers 

have used notebooks in the classroom. (If needed, 

reference the www.PiL-network.com for examples). 

The OneNote participant notebook has examples found 

in the Orange Examples section. 

4:15 15 Inquiry Lesson with Bing Have participants complete an inquiry lesson using Bing 

using the activity found on page 3 of the Content 

Development section of the participant notebook. 

file:///C:/Users/markdwest/Desktop/DLI%202014/Community/OneNote_Third%20Academy/www.PiL-network.com
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4:30 10 Lesson Sharing Spend the last 10 minutes of this session sharing lessons 

– it’s okay if participants aren’t finished, sharing may 

help provide additional ideas. 

Section #7: Using Notebooks for Student and Teacher Collaboration (30 minutes) 

4:40 5 Introduction Provide an introduction to the advanced skill of using 

OneNote for Student and Teacher Collaboration. 

Remind participants that it is not meant to be 

considered an in-depth training, and merely meant to 

inspire them to see the possibilities of the tools, think 

creatively about them, and go further in the classroom 

when appropriate. 

4:45 25 Demonstration From a high-level, discuss the different ways both 

students and teachers can use OneNote, as well as 

OneNote best practices. 

Demonstrate how to create a shared notebook by 

creating one for participants to access. 

This should include tasks like: 

 Creating a new OneNote notebook 

 Adding a new location 

 Sharing an existing notebook 

Break (10 minutes) 

Section #8: Continuing the Learning (30 minutes) 

5:20 5 Best Practices Use an analogy to discuss how OneNote is a tool that 

people are most successful at learning when it is used 

consistently – even if it’s for personal productivity. 

As participants become more familiar with the tools 

they use the most with students and other teachers, 

they will become more comfortable trying new ones. 

5:25 25 Available Resources for 

Ongoing Learning 

Direct participants to the Community site on the 

Partners in Learning Network and have them post to an 

OneNote community page. 

Show other available resources (videos and tutorials). 

Section #9: Closing (10 minutes) 

5:50 8 Q & A Answer participant questions, and address any 

remaining parking lots items. 

5:58 2 Promote Additional Learning Discuss any other Teacher Academy’s that may  

be available. 
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Conducting the Session 

Section #1: Introduction (5 minutes) 

Objectives: 

 Welcome participants 

 Logistics and session “housekeeping” items 

 Create academy teams 

 Provide a quick overview of session 

15 Minutes Before Academy Starts 

Display Slide 1: Teacher Academy – We are partners in learning 

Welcome 

Display Slide 2: Teacher Academy – The Ultimate Collaboration Tool: An Introduction to OneNote 

Do:  Introduce yourself, telling participants who you are as well as thanking them for coming. Show 

genuine excitement for having them attend the academy. 

Say: This Teacher Academy focuses on ways you can use Microsoft OneNote to enable you to 

communicate, share and collaborate in the classroom, and bring more satisfaction to you as a teacher 

and to your students as learners. The next six hours will be focused on you becoming extremely 

comfortable with OneNote in your work with education professionals and other students, and you will 

also walk away with ideas and a lesson plan that you can use with your students. 

Ask:  Ask about their experience with collaboration in the classroom and what they expect from  

the session. 

Logistics and Session “Housekeeping” Items 

 Six-hour Teacher Academy 

 Two ten-minute breaks, and a one-hour lunch 

 Restroom locations 

 Courtesy cell phone silence 

Teacher Academy Overview 

Say: It’s always better to be able to practice what you learn, so while I’m going to demonstrate a few 

things, you’ll also be working with the tools that I’ll be using. 

Display Slide 3: Objectives 

Do:  Discuss the learning objectives, and rather than reading right off of the slide, summarize in 

discussion format. Use the following script as your guide. 

Say: This Teacher Academy is designed to give you some ideas on how you can be innovative with 

students, as well as other educators, using OneNote. Today, for example, we are going to set you up 

Start at 

:00 

 

Start at 

:00 

 

Start at 

:00 

 

Start at 

:00 Start at 

:01 

 

Start at 

:00 

 

Start at 

:00 
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:02 

 

Start at 

:00 
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:00 
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:00 
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for success! We’ll start by showing you many of the tools to get you started, and then you’ll be able to 

reflect upon how you can actively use these tools in different ways with your students and other 

educators. We’ll cover a lot, but you should leave feeling inspired after having the opportunity to 

practice, as well as see how OneNote notebook examples have been used by other teachers. 

First, we’ll look at navigating OneNote…then I’ll show you how to set up notebooks for practical use. 

We’ll take a couple breaks along the way, and a lunch about half way through the day. After lunch, 

you’ll get some time to review your skills and get some practice time under your belt, before we move 

into the second half of the session, which focuses on classroom application and the creation of a lesson 

plan you can use in your own classes for student and teacher collaboration. 

We’ll close the day by giving you some best practices for keeping your skills fine-tuned, as well as 

provide some resources for how you can learn more. There’s a great deal of information out there, so 

you’ll always have access to resources that will not only keep you on track with the tools, but also 

provide further inspiration for using OneNote in the classroom. 

Any questions? 

Let’s get started! 

Section #2: OneNote Overview (45 minutes) 

Objectives: 

 Familiarize participants with the tools found on the main ribbons 

 Provide tips on navigation and efficiency 

Learning the Basics – Part I 

Display Slide 4: OneNote Basics 

Say: The beautiful thing about OneNote is that it puts everything at your fingertips, enabling you to 

communicate, collaborate and share. 

As with all Office products (like Word, PowerPoint, Excel, etc.), OneNote has a number of ribbons 

across the top that will help you as you use the tool. Let’s spend the next thirty minutes looking at the 

ribbons and what tools you will find on each one. 

Before we begin with the ribbons, let’s begin with Section 1 (Overview) and the page called “Setting up 

OneNote.” 

 

Start at 
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Do:  Demonstrate the following items: 

 Create a new notebook 

 Open a notebook 

 The Bookshelf (show how to pin and unpin the notebooks) 

 Sections (create, change colors, sub sections) 

 Pages (adding, deleting, naming) 

Say: Although it may feel a little strange at first, you don’t need to save your work because OneNote is 

constantly syncing in the background – automatically saving as you go. 

Section #3: OneNote as a Personal Organization Tool – Part I (50 minutes) 

Objectives: 

 Learn more about the tools found on the ribbon, including adding pages, inserting tabs, use of 

drawing tools, review tools and reference tools 

Using the Desktop More Effectively 

Display Slide 5: The Desktop 

Say: Now, let’s go further into the tools and navigate to the third section in your Notebook (titled Basic 

Skills). It is blue and the first page is titled “The Ribbons.” 

 

Say: Like all Office products, you can access the most often used tools through the Ribbons at the top. 

If you do not see the ribbon tools, double-click on the tab (for example, the HOME tab) to open the 

Ribbon. Double-click again to close it. We are going to look at each tab in the ribbon in detail. 

The Home Tab is mainly where you work with text. In OneNote, you can click anywhere on a page  

and start typing. 

 

Start at 

:50 

 

Start at 

:00 

 

Start at 

:00 

 

Start at 

:00 



 

 

 The Ultimate Collaboration Tool: An Introduction to OneNote – Teacher Academy 13 

Rev. 04/29/2014 

 

Say: Everyone, click “Add Page” to add a new blank page in this section. Name your page “Play Page.” 

To name it, type in the title area of the page and as you type, you will see that the name of the page  

is changed. 

Click anywhere on the page and start typing. Click anywhere else, and type again. As you can see, a 

box appears around your text and you can grab it and move it anywhere else on the page. 

In the home tab, you can format your text, but there are also two more things you may find useful, 

tags and emailing a page. We will come back to these two things later. For now, just play with the 

formatting features, which are the same features you find in Word. 

 

Say: Next up, is the Insert Tab. This is another tab that you will probably use quite a bit. 

 

Say: If you aren’t clicked in a page, many of these will be greyed out. Click anywhere on your “Play 

Page.” You can see that if you want to add anything that isn’t text to your page, this is the place to do 

it. Again, we will cover many of these in more detail later. 

Do:  Demonstrate the following things using your Play Page, noting that the focus is on the bolded items. 

Skim over the other features as they will be covered later: 

 Insert space 

 Creating tables 

 File printout 

 File Attachment (show drag and drop way as well by opening your documents folder and 

dragging a document onto the Play Page) 

 Spreadsheet (if you have a spreadsheet that you can demo with, show them how when you 

embed a spreadsheet, you click “edit” to edit it in Excel, but the spreadsheet shows as a table on 

the page). 

 Screen clipping 
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 Inserting pictures 

 Hyperlinks (also include linking  pages within the notebook) 

 Record Audio 

 Record Video 

 Page Templates 

Say: The Draw Tab is where you will spend a lot of time if you have a tablet with a touch screen. As 

you can see, OneNote has a variety of tools. We will spend more time on this tab later this morning. 

 

Say: The History Tab is especially useful in collaborative notebooks where you have multiple people 

editing and using the OneNote. 

 

Say: Let’s say that your class is working on a class project together in an OneNote notebook. The class 

is divided into teams of 4 and each team has a section of the notebook in which they are working. 

Each student has their own device they are using to access the notebook. The class has been working 

for a few weeks, and you want to see who has contributed what to the notebook. You can click “Find 

by Author” and see a list of everyone who has contributed to the notebook and when. 

Or, pretend that your team uses OneNote to store meeting notes, and you have been home sick for the 

past three days. You can use the recent edits tool to see what has been changed today, since yesterday, 

in the last 7 days and more! 
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Say: Page versions are also very important in a collaborative notebook. This is where you can see each 

iteration of a page as it has changed over time. You can see the date of the previous version and who 

changed it. When you click on the version, it shows you in green the changes. Click on “page versions” 

again, to hide all the versions. 

 

Say: Finally, the recycle bin is where you will find deleted pages and sections. Items will stay in the 

recycle bin for 60 days before they are permanently deleted. 

Review Tab 

Say: The Review tab is where you have access to powerful tools for students. 

 

Say: You can use reference tools, such as a built in dictionary and thesaurus, but another powerful tool 

is the translate button. Pretend you have a new student who doesn’t speak English, you can have them 

work in OneNote and create a two-column table. On the left side, they can work in English, and on the 

right can be the second language. Let me demonstrate for you. 
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Do:  Demonstrate these items: 

 On the Play Page, create a 2-column table. 

 Type a few sentences into the left column (in English). Copy and paste it into the right column. 

 

1. Highlight the paragraph. 

2. Click Translate (you can also right click and select translate). 

3. Choose the language you want to translate. 

4. Click Insert. 

Say: The text in the right column is replaced with the translation! Of course, this is machine 

translation, so it isn’t a perfect translation, but usually it is enough to actually get the meaning across 

and it lets the student engage in the learning. 

Password Tool 

Say: The last tool on this ribbon I want to show you is the Password tool. This is great when you are 

building a notebook that your students access to get content. Maybe you are working on building a 

lesson, but you don’t want your students to see it yet. You can create the section and then password 

protect it until you are ready for them to see it. Be aware though, that there is NO WAY to retrieve a 

password if you forget it. If you forget your password, you will have lost access to your section. 
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The View Tab 

Say: The last tab to look at is the View tab. 

 

Say: One of the cool features of this tab is the Rule Lines button. Click on it and take a look at  

the various lines you can add to your page. These are great when using a stylus and digital ink  

on the pages. 

Break (10 minutes) 

Section #4: OneNote as a Personal Organization Tool – Part II (60 minutes) 

Objectives: 

 Learn intermediate OneNote skills, including tagging, searching, hyperlinks, screen clippings, 

distributing notes, and using audio and video tools 

Diving Deeper 

Display Slide 7: Diving even Deeper 

Say: Now that you have all had a chance to get comfortable with the Ribbons, let’s take a deeper dive 

into some of the features of OneNote. Everything in the remaining part of the demo (including 

screenshots) can be found in the OneNote notebook included with this academy. 

Everything I demo for the rest of this morning will be found in the notebook section called “Basic 

Skills.” You don’t need to worry about taking notes, because all the directions are here for you. 

Searching 

Say: Let’s now jump to the page in the Basic Skills Section called “Searching for Text.” Searching is 

extremely powerful. People that have been using OneNote for years really value it. Pretend that you 

work on a team of instructional coaches where every year, you have created a OneNote notebook to 

gather meeting minutes, track decisions, plan projects and training and more. A teacher emails the 

team with a question. You remember that you answered that same question last year, but can’t 

remember what exactly was said. Fortunately, you still have last year’s notebook, so you can open it, 

do a search using some keywords, and in seconds, the page is found with the correct information. 
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Do:  Take participants through the pages in their OneNote called Searching for Text & Tags. 

 

Say: Let’s try this now! Let’s search for the word "Microsoft." 

1. Use the search box in the top right. 

2. As you type, the pages that contain the word begin to appear below - click on 

the page you want. The search first shows you the results containing 

“Microsoft” in the Title, then when it appears on the page. 

 

3. If you want to see a better view, click Pin Search Results at the bottom of the  

Search Box. 
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4. You can change the search to only search this notebook by clicking change 

and then selecting This Notebook. 

 

Ask:  Take a moment and turn to your neighbor, addressing this question: How do you imagine using 

the search feature? 

Tagging 

Say: Another critical tool is the Tagging feature. 

 

Say: Let’s practice using this feature: 

a. Click anywhere in the sentence "This is a really important idea." 

b. From the "Home" Tab, find the Tags Section Group and select "Important (Ctrl+2)." 
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Say: Now follow steps c, d and e in the Practice Tagging section of the notebook. 

Note:  Participants will use CTRL+3 to insert a question tag and to investigate other tags available. 

Ask:  Turn to your neighbor and address the following question: How do you see using the tag feature? 

Say: Now let’s practice searching for tags! 

a. Tags help you easily find things based on how you have used them in  

your notebooks. 

b. In the "Tags" Section of the Home Tab, click the "Find Tags" button 

 

 

c. You can sort by tag name, section, title, or date. 

d. TIP! If you use the "To Do" tag, you can tell it to only show unchecked items  

(very helpful). 

e. You can search in all notebooks, or just one of them, or just a section. 
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Say: You can also customize your tags however you want using Customize My Tags at the bottom of 

the drop-down menu. If you use OneNote at work, you can create tags that match your occupation. 

Similarly, students can use tags that are keyed to specific academic tasks. 

 

Do:  Point the participants to the hyperlink at the bottom of the page for more detailed help on searching 

for tagged notes: http://office.microsoft.com/en-us/onenote-help/search-for-tagged-notes-

HA102749119.aspx?CTT=5&origin=HA104118882 

Hyperlinks and Screen Clippings 

Say:  Hyperlinks in OneNote are great when you are using OneNote to build curriculum that you are 

going to deliver. OneNote is a fantastic way to create an interactive textbook that you can then give to 

your students. By including hyperlinks, students can easily jump from one part of the notebook to 

content on the internet or to another part of the notebook. 

Or, imagine that you are a group of 3rd graders creating a “Choose your own adventure” storybook. 

The entire book could be created in OneNote and then at the end of each page, the students could put 

choices that their readers get to select from and then link them to where the story continues based on 

their choice. 

Screen clippings are perfect for taking screenshots, or for capturing content from the internet  

for research. 

Let’s go through these in more detail. As always, everything I show you here is in your OneNote 

notebook, so if you miss something I say or do, you have a copy of it. 

Create a link 

Say: When you type a web address (URL) in your notes, OneNote automatically formats it as a 

clickable link. 

For example, if you type http://www.microsoft.com or www.microsoft.com, OneNote would format 

either URL style as a link which you can click to open the Microsoft website. 

  

http://office.microsoft.com/en-us/onenote-help/search-for-tagged-notes-HA102749119.aspx?CTT=5&origin=HA104118882
http://office.microsoft.com/en-us/onenote-help/search-for-tagged-notes-HA102749119.aspx?CTT=5&origin=HA104118882
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Say: You can also manually add links in your notes. 

1. On the Insert tab, click Link. 

2. In the Link dialog box, type a description of the link destination into the Text 

to display box. If you have text on your page selected, OneNote will fill this 

field in  

for you. 

3. In the Address box, type the full URL or web address that you want the link to 

open, and click OK. 

 

Say: In addition to creating regular hyperlinks that point to the Web (Insert > Hyperlink), you  

can create hyperlinks to any part of your notes (a notebook, a section, a page, or even a  

specific paragraph.) 

Use such OneNote hyperlinks to create: 

 A table of contents on a page with links to the other pages in the section or with links to other 

parts of the same page. 

 A favorites list, a list of links to pages and sections that you need to visit frequently. 

 A definition or reference link from a term, a name, or a topic on one page to more detailed 

information in another place in your notes. 

Say: To create a hyperlink, right-click the tab or note you want to link to and then do the following: 

1. Click Copy Hyperlink to this Page. 

2. Click Paste to place the link where you want it to appear (you can press 

CTRL+ V, or Right Click + Paste, or Home Tab + Paste). 

Say: You can even paste the link outside OneNote. For example, you can send the link to others in 

an e-mail. They can click it to jump to your notes (if the notes are in a shared notebook). 
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Try it now 

Say: Create a link on this page to another page. 

Note:  Use the Back arrow on the toolbar to get back to this page after you copy the link. 

Inserting screen clippings 

Say: Let’s insert a screen clipping on the current page 

1. Bring into view whatever you want to clip, such as a portion of a web page. 

2. In OneNote, click where you want the screen clipping to appear, and then 

click Insert > Screen Clipping 

3. When the screen dims, select an area of the screen by dragging the mouse 

pointer over it. 

Say: When you let go of the mouse button, the screen clipping will be in your notes. 

Take a screen clipping and send it to any notebook 

1. Start by bringing into view what you want to clip. 

2. On your keyboard, hold down the Windows Logo key, and then press S. (If 

using Win 8, press Windows+Shift+S.) 

3. When the screen dims, select an area of the screen by dragging the mouse 

over it. 
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4. When you let go of the mouse button, the Select Location in OneNote 

dialog  

box appears. 

5. In the Select Location in OneNote dialog, choose where you want the 

screen clipping to be placed, and then click Send to Selected Location. 

Say: If taking screenshots from the Internet, the URL will follow – great for collecting research. 

 

Templates 

Say: Why are templates so special? They can: 

1. Enhance the look of your pages. 

2. Help you avoid retyping common information across pages. 

3. Present you with design options that lay out your information more 

efficiently. 

Say: You can use any of the designs included with OneNote or you can create your own. 

Templates are great when you create pages that repeatedly have the same structure and header, such 

as in meeting notes, lesson planners, behavior tracking, phone call notes, student progress, portfolios 

and more. 

Choose from built-in templates 

Say: Let’s try this together! 

1. Go to the section where you want to add a page. 

Insert (Tab) > Page Templates 
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2. To use one of the built-in page templates, expand the type of template you 

want, then click the template that you want. 

 

Create your own 

1. Create a new blank page (or start with one of the built-in Templates). 

2. Add Titles, graphics, anything you like. 

a. An example might be, to create a table that you want to appear on  

all pages. 
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Insert Tab > Page Templates 

1. At the bottom of the panel, select Save current page as template. 

2. Name the template, check the box to save it as the default for all new pages 

in the section. 

3. If you want to use this template in other sections, open the template panel, 

and use the Choose default template dropdown to select your template. 

 

 

Note:  Templates are local to the computer that you are working on. If you switch computers your 

templates won't be there. 

Turn to a partner 

Do:  Have participants brainstorm reasons why they might want to use templates. After 5 minutes, have 

them report back and share their findings with the whole group. 
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Drawing 

Say: If you have an interactive whiteboard or tablet, the Drawing tools are especially helpful. However, 

the shape tools are extremely helpful for all OneNote users. 

Do:  Demonstrate each of the following tasks on the next few pages, having the participants practice 

along with you, using the instructions found in the OneNote notebook. When you get to the last tool (Ink 

to text and Ink to Math), give them plenty of time to play with those features. 

Click on any of  

the pen Tools and 

draw something, 

  

  

  

  

 

  

Try the Eraser tool. 

 

Try the Lasso Select  

to gather what you 

just drew. 

 

To get out of the  

pen Tool either,  

click ESC (escape),  

or the Type button. 
 

What does the 

Panning Hand  

tool do? 
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Try out the various 

Shape options. 

 

Now click the  

Insert Space button 

and see if you can 

insert space above 

this table. 

  

See if you can get rid 

of the space you just 

inserted using the 

button again. 

 

Draw a parallelogram, 

select it and then use 

the rotate button to 

change how it looks. 

  

Note: The rotate 

button stays grayed 

out until something is 

selected that can be 

rotated (image, 

shape, etc.) 
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If you have a stylus 

and a tablet/slate: 

Use the pen tool to 

write something. 

Then use the Ink to 

Text button to 

change it! 

 

  

  

Audio and Video Recording 

Note:  You must have a microphone to record audio and a webcam to record video. 

Say: Teachers over the years have found the recording audio and video tool very powerful in the 

classroom. One example comes from a first grade teacher. For those of you who aren’t first grade 

teachers, one of the most important skills that a first grader needs is to become a fluent reader. 

When you teach first grade, you devote a lot of time to listening to each student read and providing 

good feedback so that they can become more fluent readers. One teacher came up with a great way of 

using OneNote to help her with this workload. 

She set up an OneNote in which each section was a day. In each section, there was a page with a 

student’s name on it. She pasted in a screenshot of a reading passage and then during reading 

stations, students would rotate to the computers in the back of the classroom, put on their headsets, 

find their name and use the record audio tool to record themselves as the read the passage. When 

they were finished, they could listen to themselves. If they weren’t satisfied, they were welcome to 

delete it and try again. The teacher could then use her in-class time focused on providing support and 

then listen to the students after they had gone home for the day. She could then leave audio 

recordings on the student pages with her comments. The teacher noticed that her students’ reading 

fluency began to soar. 

Now let’s pretend that we are listening to someone give us directions, as we start to practice with 

audio and video tools. 

1. Navigate to this page and be sure that you have your volume turned up: 

http://office.microsoft.com/en-us/onenote-help/video-start-up-onenote-

2013-and-start-taking-notes-VA104050064.aspx 

2. Pause the video while you prepare to record. 

http://office.microsoft.com/en-us/onenote-help/video-start-up-onenote-2013-and-start-taking-notes-VA104050064.aspx
http://office.microsoft.com/en-us/onenote-help/video-start-up-onenote-2013-and-start-taking-notes-VA104050064.aspx
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3. Click anywhere in the cell on the OneNote page (just before step 4 is a  

good place). 

 

4. Click the Insert Tab and Record Audio. You will see a recording suddenly 

inserted below, and a new contextual tab appears in the ribbon with some 

play/pause options. 

5. Start typing below while the recording plays. Do your best to take notes as if 

you are in a lecture. 

 

Say: Recording is linked to the notes that you take. A small audio/video icon will appear next to 

notes associated with a recording. You can click it to jump to the corresponding time in the recording. 

 

6. After about 90 seconds, stop the recording using the ribbon. 

Say: Play back the recording (using the buttons in the ribbon) and watch what happens! 

Note:  As with any type of recording, you should always ask others for permission before you record your 

conversations with them. More help and how-to is available at:  

http://office.microsoft.com/en-us/onenote-help/record-audio-or-video-notes-HA102749811.aspx?CTT=1 

http://office.microsoft.com/en-us/onenote-help/record-audio-or-video-notes-HA102749811.aspx?CTT=1


 

 

 The Ultimate Collaboration Tool: An Introduction to OneNote – Teacher Academy 31 

Rev. 04/29/2014 

 

Say: The video record tool works the same way. Think about some of the ways students can utilize 

these tools, and jot them down in your notebook as ideas come to mind. 

Note:  Use this as a learning opportunity, but gauge the circumstances wisely. This can be a great 

opportunity for an activity, but only if headsets are available. If they are not available, simply stick to 

talking points on this topic. 

Closing Notebooks vs. Deleting Notebooks 

Say: On occasion, you will want to delete old OneNote notebooks that you don't need anymore. To do 

this, you must first close the OneNote notebook from within OneNote, then you need to find the folder 

that contains the notebook (it might be in your OneDrive, in an Office 365 Team Site, on your file 

server folder, or on your computer) and delete it. 

Note:  If anyone else is using this OneNote, they will still see it open in their bookshelf, but will see a red 

"not connected" symbol next to it. If they want to keep using this, they will have to follow the directions 

for how to "move" the notebook to a new location. 

Say: Let’s get started by closing every open OneNote notebook on every computer here in the room. 

1. Close the OneNote on every computer that has it open 

a. Right click on the notebook on the "bookshelf". 

b. Select Close this Notebook. 

2. Repeat at each computer that has this notebook open. 

Say: Closing a notebook does not get rid of it. It still exists wherever you have it stored. To delete it, 

you need to go to the source. 
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Say: Let’s continue getting to the source of the notebook. 

3. Navigate to where the notebook lives and delete it. 

a. Check the box next to the Notebook 

b. Select Manage 

c. Select Delete 

From OneDrive: 

 
 

4. From Your Computer 

a. Navigate to Documents > OneNote Notebooks 

b. Right-click on the folder that contains the OneNote Notebook 

c. Click Delete 

From Your Computer (My Documents > OneNote Notebooks) or a File Server Folder 

 

5. From Office 365 OneDrive for Business 

Or…  

From Office 365 Team Site, navigate to the notebook 
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a. Check the box next to the Notebook 

b. Click the ellipses (…) to the right of the name 

c. Click the ellipses (…) at the bottom of the box that pops up 

d. Click delete 

From Office 365 OneDrive for Business and Office 365 Team Sites 

 

Distributing Pages 

Say: Whenever you want to share notes or ideas about a particular meeting, event, or project with 

someone else, OneNote gives you several ways to send snapshots of your notes to others without 

giving them access to your entire notebook. 

Send a page of notes in Outlook 

Say: If you have Outlook installed, you can quickly share a page of notes in an email message. 

1. In OneNote, navigate to the page you wish to send. 

2. Click Home > Email Page. 
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3. A message window opens. Type the appropriate information in the To, Cc, 

Bcc  

(if available), and Subject boxes. 

4. In the message, add any comments for the recipients of your notes, and then  

click Send. 

Attach notes to an email message 

Say: If you don’t have Outlook, you can still attach notes to messages sent with another email service. 

1. In OneNote, go to the notebook containing the notes you want to send. 

2. Click File > Export. 

 

3. Under Export Current, choose whether you want to create a copy of the 

current page, the entire section, or the entire notebook. 

4. Under Select Format, click Page, Section, or Notebook, and then choose 

the type of file you want to create. For example, to send your notes to another 

OneNote user, choose one of the OneNote section formats – either 2010-

2013 or 2007. To send notes to someone who doesn’t have OneNote, choose 

the PDF (Portable Document Format) option. 

5. Click Export, choose a location for the file (such as your computer’s desktop), 

and then click Save. 

6. In your email service, create a new message, and then attach the file. 

Do:  Direct participants to the “more help” link at the bottom of the OneNote page: 

http://office.microsoft.com/en-us/onenote-help/distribute-notes-HA102809477.aspx?CTT=1 

 

http://office.microsoft.com/en-us/onenote-help/distribute-notes-HA102809477.aspx?CTT=1
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Say: OneNote is great for gathering your thoughts before you are ready to create a final or formal 

document. Gather your thoughts and let your ideas flow freely by using the flexible and unrestricted 

page layout in OneNote. Then, export your final to Word for distribution. 
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When you are ready to put the finishing touches on the final document, click: 

File > Send To > Microsoft Office Word (Office Word 2003, 2007, or 2010 are required). 

Side notes 

Say: How many times have you been sitting at your desk and the phone rings? You can’t find a pencil 

anywhere, but need to jot something down quickly. Side notes are the perfect tool! Especially because 

you don’t even have to have OneNote open. 

For this, I want all of you to close out of OneNote by using the x in the upper right hand corner. 

 

1. Let’s pretend the phone rings, and I answer it. It is someone calling me back 

with important information. Without even having OneNote open, I can press 

the Windows key + N to launch the Send to OneNote feature. 
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2. Select New Quick Note (or press "N" again). 

 

3. A purple "post it" appears. Type your notes as you talk on the phone and then 

just "exit" by clicking the X in the top right corner. (No need to save.) 

4. This will be found in your Quick Notes at the bottom of your "bookshelf". Let’s 

start up OneNote again and look in the Quick Notes for the note we just took. 

 
 

5. You can move the information easily by either: 

▪ Moving the page by dragging it and dropping it where you want it, or… 

▪ Highlighting the text on the page, then coping and pasting it where you want it. 

Lunch Break (60 minutes recommended) 

Section #5: Skills Review (40 minutes) 

Objectives: 

 Give participants the opportunity to practice all skills learned from the first part of the session. 

Review of all Skills Learned 

Display Slide 9: Skills Review 

Say: In this part of the session, we’re going to focus on simply giving you to the opportunity to review 

everything you have learned so far. 

Do:  Direct participants to the Review notebook, and have them practice and/all tasks from the  

morning session. 

Start at 

2:50 

 

Start at 

:00 

 

Start at 

:00 

 

Start at 
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Section #6: Using OneNote in the Classroom (70 minutes) 

Objectives: 

 Provide participants an opportunity to create a lesson they can immediately use in the classroom, 

through hands-on application 

Introduction 

Say: In the next part of the session, we will be focusing on OneNote for delivery of curriculum. There 

are many ways to use OneNote in the classroom: 

1. Personal productivity 

2. Delivery of curriculum 

3. Collaboration on a Shared Folder/SharePoint/SkyDrive or Office 365 

Exploring Notebook Examples 

Do:  Explore notebook examples, showing some ways other teachers have used notebooks in the 

classroom (www.PiL-network.com is a good place to find examples). The OneNote participant notebook 

has examples as well, which can be found in the Orange Examples section. 

Inquiry Lesson with Bing 

Do:  Have participants complete an inquiry lesson using Bing using the activity found on page 3 of the 

Content Development section of the OneNote participant notebook. 

  

Start at 

3:30 

 

Start at 

:00 

 

Start at 

:00 

 

Start at 

:00 

Start at 

3:35 

 

Start at 

:00 

 

Start at 

:00 

 

Start at 

:00 

Start at 

4:15 

 

Start at 

:00 

 

Start at 

:00 

 

Start at 

:00 

file:///C:/Users/markdwest/Desktop/DLI%202014/Community/OneNote_Third%20Academy/Alpha/www.PiL-network.com
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Task Screenshots/Resources 

Explore Notebook Examples 

Spend time showing examples of ways other teachers have used notebooks in the 

classroom (www.PiL-network.com is a good place to find examples). 

The OneNote participant notebook has examples as well, which can be found in the 

Orange Examples section. 

Have participants complete an inquiry 

lesson using Bing and the activity found 

on page 3 of the Content Development 

section of the participant notebook. 

 

Show the components of a good 

interactive lesson using resource linked 

in the participant's notebook. 

Provide the remainder of this session to 

let participants create their own 

interactive lesson they can use with their 

students. This is a great opportunity to 

reinforce skills used in the morning 

skills training. 

 

http://www.pil-network.com/
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Remind them to look through the list of 

ways that OneNote can help a teacher 

meet the U.S. Common Core State 

Standards found in the Overview Tab 

(very first page). 

 

Packaging a Notebook as a Single File 

Once you have built out a notebook of 

lessons, you will want to save the 

notebook as a single file. That way every 

student will have their own version. 

1. File 

2. Export 

3. Choose either page, section  

or notebook 

4. Select format 

5. Export and save the file in a location 

students have access to (shared server 

folder, class site, etc.) 

If saving a page or a section, students 

will need directions on navigating to 

their correct notebook. 

 

Lesson Sharing 

Do:  Spend the last 10 minutes of this session sharing lessons – it’s okay if participants aren’t finished, 

sharing may help provide additional ideas. 

Section #7: Using Notebooks for Student and Teacher Collaboration (30 minutes) 

Objectives: 

 Explore various ways to use OneNote to collaborate with others 

 Create a shared notebook using OneDrive 

 Understand how OneDrive can create OneNote opportunities for students and teachers using 

Office Online 

OneNote and Collaboration Introduction 

Display Slide 10: Notebooks and Collaboration 

Note:  There is a free version of OneNote for every device: http://www.onenote.com. Since this is more of 

an advanced skill, this is merely an introduction, and not meant to provide an in-depth training. You can 

also point them to the Videos to Watch page if they want to see a couple of examples. 

Start at 

4:40 

 

Start at 

:00 

 

Start at 

:00 

Start at 

4:30 

 

Start at 

:00 

 

Start at 

:00 

 

Start at 

:00 

http://www.onenote.com/
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Say: OneNote provides some exciting collaborative opportunities for students and teachers. 

 

For teachers and other professionals: 

1. Virtual whiteboard during brainstorming sessions 

2. Collaborative lesson planning 

3. Professional Growth Plan 

4. Staff meetings 

5. Guidance meetings 

6. Content teachers planning with others across the district 

Say: For students: 

1. Journals 

2. Writing assessment 

3. Teaching math concepts using the audio tool and asking for student input 

4. Problem based learning projects 

5. Group research projects 

6. Peer to peer tutoring 

Say: When Sharing a OneNote Notebook: 

Always: Have protocols in place (no deleting pages or others' work). 

Never: Move the notebook to a different location without providing others the new link. 

Demonstration 

Say: Let’s take a look at how to create a new OneNote notebook on either your Personal OneDrive, 

your Office 365 OneDrive, or on an Office 365 Team Site: 

1. On the File menu, click New. 

2. Under New Notebook, choose where the new notebook should be stored. 

a. You can Add a Place (such as an Office 365 account, a personal 

OneDrive location), or a file-share folder. 

b. In the example on the right, I have clicked on an Office 365 account, 

and then off to the right, I have a variety of Document Libraries on 

that Team Site, OR my own personal OneDrive for Business space. 

Start at 

4:45 

 

Start at 

:00 

 

Start at 

:00 

 

Start at 

:00 
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Adding a new location 

1. Select Add a Place. 

2. Select if it is an Office 365 or Personal OneDrive location. 

3. Type in the email associated with that location. 

 

 

 

Say: If that doesn't work, try Adding a service in the Account management area. 
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Share an existing notebook 
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Say: Or you can just create a link that you send out in an email, or post on a website 

 

Break (10 minutes) 

Section #8: Continuing the Learning (30 minutes) 

Objectives: 

 Learn about OneNote best practices, ways to support ongoing skill support, and future learning 

Best Practices 

Display Slide 12: Supporting Your Ongoing Learning 

Say: To be the most effective in your ongoing use of OneNote, it is important to use the tool 

consistently – even if it’s for personal productivity. As you become more familiar with the tools you use 

the most, you will become more comfortable with trying other tools. 

For instance, here’s an analogy to consider… 

Display Slide 13: Biking with OneNote 

Say: Learning OneNote is a lot like learning to ride a bicycle. None of us took bike-riding classes, we 

didn’t watch video tutorials, we didn’t research and write reports on it, and we didn’t have experts give 

us advice. We learned by getting on the bike and riding it. The most instruction that we probably got 

was an adult yelling “pedal faster” as we went 3-5 feet before falling off. We got back on the bike and 

kept trying. We started falling less and less until one day, we just got on the bike and rode it. OneNote 

is very similar. You can take hundreds of classes on OneNote, but the one thing that will teach you 

about OneNote better than anything else is simply to use it and keep using it regularly. The more you 

use it, the more comfortable you will feel, until one day, you realize that it’s just a part of you and your 

work and you can’t imagine life without it! 

Do:  If possible, add a second short analogy or related example from your experience. 

 

Start at 

5:20 

 

Start at 

:00 

 

Start at 

:00 

 

Start at 

:00 
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Available Resources for Ongoing Learning 

Display Slide 14: Making a Commitment 

Do:  Reach a consensus to have everyone commit to these basic “to-do” items for ongoing learning and 

the honing of skills (build the slide to reveal them). These items are also contained in the Participant 

OneNote notebook (red section, page 1 of “Continue the Learning”): 

1. Commit to creating and using ONE OneNote notebook. It could be for 

personal use (like a recipe book), or professional use (lesson planning). Just 

something that they can spend at least 10 minutes on each day. 

2. Direct them to the Community site on the Microsoft Educator Network and 

have them post to a OneNote community page (hyperlink provided on the 

OneNote page). 

3. Discussions with other educators - Interactive Lessons Using OneNote 

Post a response to the following question:  

What are ways you create or are planning to create interactive lessons using OneNote? 

Do:  Afterwards, show participants OneNote Help Resources and Additional Resources. (These items are 

also contained in the Participant OneNote notebook (red section, page 2-3 of “Continue the Learning”): 

1. Page 2 – OneNote Help Resources 

Show the other resources available (videos and tutorials). Show everyone that 

pressing F1 while in a program brings up the help. If they like keyboard 

shortcuts, show them that link on the page. 

2. Page 3 – Additional Resources 

Give them time to click through and explore the additional resources linked on  

this page. 

Section #9: Closing (10 minutes) 

Objectives: 

 Answer participant questions, and address any remaining parking lot items 

 Discuss any other Teacher Academy’s that may be available 

Q & A 

Display Slide 15: Q & A 

Do:  Answer any participant questions, and address any remaining parking lot items. 

Promote Additional Learning 

Display Slide 16: Teacher Academy’s 

Say: I hope you’ve enjoyed today’s Teacher Academy and that you take the skills you learned today 

and use them in your classrooms. 

Do:  Mention any other academy’s available. 
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http://www.pil-network.com/Discussion/9e648c94-0c56-4d4a-904e-ff5103ad7432

